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ESP8266 Web Server with Arduino IDE

Hello and thank you for downloading this project eBook!

This quick eBook is my step-by-step guide designed to help you build a web
server with a WiFi module called ESP8266.

About the ESP8266

The ESP8266 is a $4 (up to $10) WiFi module with an ARM processor that

is great for home automation/internet of things applications.

So what can you do with this low cost module?

You can create a web server, send HTTP requests, control outputs, read

inputs and interrupts, send emails, post tweets, etc.

ESP8266 specifications

e 802.11 b/g/n protocol

e Wi-Fi Direct (P2P), soft-AP

e Integrated TCP/IP protocol stack
e Built-in low-power 32-bit CPU

e SDIO 2.0, SPI, UART
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Finding Your ESP8266

The ESP8266 comes in a wide variety of versions. The ESP-12E or often

called ESP-12E NodeMCU Kit is currently the most practical version and
that’s the module we’ll be using most throughout this eBook.

This project was tested with ESP-01, ESP-07, ESP-12 and ESP-12E. So you

can make all the projects presented in this eBook using any of those boards.

I highly recommend using the ESP8266-12E NodeMCU Kit, the one that has
built-in programmer. The built-in programmer makes it easy to prototype

and upload your programs. Click here to buy this module on eBay.

LATEST PROJECTS - DOWNLOAD MORE RNT PRODUCTS - HOME AUTOMATION USING ESP8266 3



http://randomnerdtutorials.com/
http://randomnerdtutorials.com/products
https://randomnerdtutorials.com/home-automation-using-esp8266/
http://ebay.to/1jU3piA
http://ebay.to/1jU3piA

ESP-12E NodeMCU Kit Pinout

Here’s a quick overview of the ESP-12E NodeMCU Kit pinout:
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DB(GPI016) can only be used as gpio read/write, no interrupt supported, no pwm/i2c/ow supported.
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ESP8266 with Arduino IDE

In this section you're going to download, install and prepare your Arduino
IDE to work with the ESP8266. This means you can program your ESP using

the friendly Arduino programming language.

The Arduino IDE is an open-source software that makes it easy to write code

and upload it to the Arduino board. This GitHub repository added support
for the ESP board to integrate with the Arduino IDE.

The Arduino IDE is a multiplatform software, which means that it runs on
Windows, Mac OS X or Linux (it was created in JAVA).

Requirements

You need to have JAVA installed in your computer. If you don’t have, go to

this website: http://java.com/download, download and install the latest

version.

To download the Arduino IDE, visit the following URL:

https://www.arduino.cc/en/Main/Software.

Then, select your operating system and download the software (as shown
below).
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Home Buy Download Products -~ Learning « Forum Support ~ Blog LOG IN SIGN UP

Download the Arduino Software

Windows installer
Windows zIF file for non admin install

ARDUINO 1.8.0 Windows app| Get 2} |

The open-scurce Arduine Software (IDE) makes it easy to

write code and upload it to the board. It runs on MEC os X10.7 Lion or newer
Windows, Mac OS5 X, and Linux. The environment is

% written in Java and based on Processu'lgawc other open- .
T Linux 32 bits

This software can be used with any Arduino board. Linux 64 bits
Refer to the Getting Started page for Installation Linux ARM
instructions.

Release Notes
Source Code
Checksums (sha512)

Grab the file you’ve just downloaded named “arduino-(...).zip”. Run that file

and follow the installation wizard that shows on your screen. Open the

Arduino IDE application file (see figure below).

Name - Date modified Type Size

dist 13/08/2015 20:33 File folder

drivers 13/08/2015 20:53 File folder

examples 13/08/2015 20:54 File folder

hardware 13/08/2015 20:54 File folder

java File folder

lib 13/08/2015 20:3 File folder

libraries File folder

reference 13/08/2015 21:03 File folder

tools 13/08/2015 21:03 File folder
arduino 14/08/2015 17:42 Application 393 KB
:B arduino.l4j 13/08/2015 20:53 Configuration sett... 1KB
@ arduino_debug 13/08/2015 20:53 Application 390 KB
:B arduino_debug.|4j 13/08/2015 20:33 Configuration sett... 1KB
libusb0.dll 13 2015 20:53 Application extens... 43 KB
msvcp100.dIl 13/08/2015 20:33 Application extens... N2 KB
msver100.dll 13/08/2015 20:53 Application extens... 753 KB
D revisions 13/08/2015 20:33 Text Document 66 KB
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When the Arduino IDE first opens, this is what you should see:

sketch_aug22a | Arduino 1.6.5 - O ¥
File Edit Sketch Tools Help

sketch_aug22a

k:id setup() { A
S/ put your setup code here, to run once:

}

vold loop() {
S/ put your main code here, to run repeatedly:

Arduing Uno on CORG

Installing ESP8266 Board

To install the ESP8266 board in your Arduino IDE, follow these next

instructions:

1. Open the preferences window from the Arduino IDE. Go to File >
Preferences

2. Enter http://arduino.esp8266.com/stable/package esp8266com in

dex.json into Additional Board Manager URLS:s field and press the
“OK” button

LATEST PROJECTS - DOWNLOAD MORE RNT PRODUCTS - HOME AUTOMATION USING ESP8266 7



http://randomnerdtutorials.com/
http://randomnerdtutorials.com/products
https://randomnerdtutorials.com/home-automation-using-esp8266/
http://arduino.esp8266.com/stable/package_esp8266com_index.json
http://arduino.esp8266.com/stable/package_esp8266com_index.json

Preferences

Sketchbook location:

C:Wsers\Rui Santos\Documents VArduing

Editor font size: |12
Show verbose output during: [ | compilation [ ] upload

Compiler warnings: |Mone  «

[] visplay line numbers

[] Enable Code Folding

Verify code after upload

[] use external editor

Chedk for updates on startup

Update sketch files to new extension on save (.pde -> .ina)

Save when verifying or uploading

More preferences can be edited directly in the file

C:\Jsers\Rui Santos\AppData'RoamingArduino 15\preferences. txt

(edit only when Arduino is not running

Editor language: | System Default ~ | (requires restart of Arduino)

Additional Boards Manager URLs: | http:/farduine. esp8266., com/stable /package_espd 266:0m_index.json|

0K

Browse

Cancel

3. Goto Tools > Board > Boards Manager...

sketch_aug22a | Arduing 165

File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

sketch_aug2 s

woid setup() Serial Monitor Ctrl+ Shift+M
[/ put your
Board: "Arduino Uno"
! Port
woid loop() { Programmer: "AVRISP mkll"
[/ put your

Burn Bootloader

Boards Manager... I

Arduino AVR Boards
Arduine Yin

Arduine Uno

Arduine Duemilanove or Diecimila
Arduinc Nano

Arduinc Mega or Mega 2360
Arduinc Mega ADK
Arduino Leonardo

Arduino Micro

Arduino Esplora

Arduino Mini

Arduino Ethernet

Arduine Fio

Arduino BT

LilyPad Arduino USB
LilyPad Arduine

Arduino Pro or Pro Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor

Arduino Gemma
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4. Scroll down, select the ESP8266 board menu and Install “esp8266 by
ESP8266 Community”

Boards Manager *

Type Al wr seardi...

4
T
i
.
o
I
[T

Intel i686 Boards by Intel
Boards included in this packaga:
Edisan.

More info

AMEL-Tech Boards by AMEL Technology
Boards included in this package:
SmartEverything Fox.

Cnline help
More info

esp8266 by ESP8266 Community
Boards included in this package:
Generic ESP8266 Module, Olimex MOD-WIFI-ESPEB266(-DEV), NodeMCU 0.9 (ESP-12 Module), NodeMCU 1.0 (ESP-12E Module), Adafruit HUZZAH
ESP8266 (ESP-12), SweetPea ESP-210.
Online help
More info
Install

b

Close

5. Open the Arduino Tools menu
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6. Select Board > NodeMCU 1.0 (ESP-12E Module)

Tools Help
Auto Format
Archive Sketch
Fix Enceding & Relead
Serial Monitor

Serial Plotter
WiFi101 Firmware Updater

Board: "ModeMCU 1.0 (ESP-12E Module)”
CPU Frequency: "80 MHz"

Flash Size: "4M (3M SPIFFS)"

Upload Speed: "115200"

'Y
LikyPad Arduino

Arduine Pro or Pro Mini
Arduine NG or older

Port Arduine Robot Control

Get Board Info Arduine Robot Motor

Arduine Gemma
Programmer: "AVRISP mkll" ;

Burn Bootloader

ESP32 Arduing

ESP32 Dev Medule

Electronic SweetPeas - ESP320
Nana32

WEMOS LoLin32

ESPea32

Moduine Quantum

MNode32s

ESP8266 Modules

Generic ESP8266 Module
Generic ESP8285 Module
ESPDuino (ESP-13 Module)
Adafruit HUZZAH ESP2266
ESPresso Lite 1.0

ESPresso Lite 2.0

Pheoenix 1.0

Pheoenix 2.0

NodeMCU 0.9 (ESP-12 Moadule)

———| & NodeMCU 1.0 (ESP-12E Module) |

7. Finally, re-open your Arduino IDE to ensure that it launches with the

new boards installed
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In this section, you're going to design a simple circuit to blink an LED with
the ESP using Arduino IDE.

Why do we always blink an LED first? That’s a great question! If you can
blink an LED you can pretty much say that you can turn any electronic device

on or off.

Writing Your Arduino Sketch

The sketch for blinking an LED is very simple. You can find it in the link

below:

SOURCE CODE

https://qist.github.com/RuiSantosdotme/789861277da9680e9ctb

int pin = 2;

void setup() {
// initialize GPIO 2 as an output.
pinMode(pin, OUTPUT);

// the loop function runs over and over again forever
void loop() {
digitalWrite(pin, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(pin, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}
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Uploading Code to ESP8266

Upload code to your ESP-12E NodeMCU Kit is very simple, since it has built-

in programmer. You plug your board to your computer and you don’t need

to make any additional connections.

Look at the Tools menu, select Board “NodeMCU 1.0 (ESP-12E Module)”
and all the configurations, by default, should look like this:

'@' sketch_dec2%a | Arduing 1.6.13
File Edit Sketch Tools Help

sketch_dec29:

vold setu

// put

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter
WiFi101 Firmware Updater

Board: "ModeMCL 1.0 (ESP-12E Module)”
CPU Frequency: "80 MHz"

Flash Size: "4M (3M SPIFFS)"

Upload Speed: "115200"

Port: "COME"

Get Board Info

Ctrl+T

Ctrl+5hift+ M
Ctrl+5hift+L

Programmer: "AVEISP mkdl"

Burn Bootloader
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Important: your COM port is very likely to be different from the preceding
screenshot (Port: “COM®6”). That’s fine, because it doesn’t interfere with
anything. On the other hand, all the other configurations should look exactly

like mine.

After checking the configurations, click the “Upload Button” in the
Arduino IDE and wait a few seconds until you see the message “Done

uploading.” in the bottom left corner.

Upload Button

ialize GPIO 0 as an output

is the voltage level)

by making the voltage LOW

Final ESP-12E circuit
Connect an LED and a 220 Ohm resistor to your ESP D4 (GPIO 2).

Powering the ESP8266|
through the USB connector

fritzing
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Restart your ESP8266. Congratulations, you’ve made it! Your LED should be

blinking every 1 second!
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ESP8266 Weh Server

In this project, you're going to build a web server that controls two LEDs.
This is just an example the idea is to replace those LEDs with a relay to

control any electronic devices that you want.

Writing Your Arduino Sketch

Let’s create a web server that controls two outputs (GPIO 5 and GPIO 4).

Copy the sketch below to your Arduino IDE. Replace the SSID and password

with your own credentials.

After modifying my sketch upload it to your ESP8266 (If you can’t upload
code to your ESP8266, read this troubleshooting guide).

SOURCE CODE

https://qist.github.com/RuiSantosdotme/802869a70fage83ec78826d38ca89c4c

/*********

Rui Santos

Complete project details at http://randomnerdtutorials.com

*********/

#include <ESP8266WiFi.h>
#include <WiFiClient.h>
#include <ESP8266WebServer.h>
#include <ESP8266mDNS.h>

MDNSResponder mdns;
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// Replace with your network credentials
const char* ssid = "YOUR_SSID";
const char* password = "YOUR_PASSWORD";

ESP8266WebServer server(80);

String webPage = 5

int gpio5_pin 5;
4;

int gpio4_pin

void setup(void){
webPage += "<h1>ESP8266 Web Server</hl><p>Socket #1 <a
href=\"socket10On\"><button>ON</button></a>&nbsp;<a
href=\"socket10ff\"><button>0FF</button></a></p>";
webPage += "<p>Socket #2 <a
href=\"socket20n\"><button>0ON</button></a>&nbsp;<a
href=\"socket20ff\"><button>0FF</button></a></p>";

// preparing GPIOs
pinMode(gpio5 pin, OUTPUT);
digitalWrite(gpio5 pin, LOW);
pinMode(gpio4 pin, OUTPUT);
digitalWrite(gpio4 pin, LOW);

delay(1000);
Serial.begin(115200);
WiFi.begin(ssid, password);

Serial.println("");

// Wait for connection

while (WiFi.status() != WL_CONNECTED) {
delay(500);
Serial.print(".");

}

Serial.println("");

Serial.print("Connected to ");

LATEST PROJECTS - DOWNLOAD MORE RNT PRODUCTS - HOME AUTOMATION USING ESP8266 16



http://randomnerdtutorials.com/
http://randomnerdtutorials.com/products
https://randomnerdtutorials.com/home-automation-using-esp8266/

println(ssid);
print("IP address: ");
println( localIP());

(mdns.begin("esp8266", localIP())) {
println("MDNS responder started");

server.on("/", [1O{
server.send(200, "text/html", webPage);

}s

server.on("/socket1i0on", [1(){
server.send(200, "text/html", webPage);
digitalWrite(gpio5_pin, HIGH);
delay(1000);

}s

server.on("/socket10ff", [1(){
server.send(200, "text/html", webPage);
digitalWrite(gpio5_pin, LOW);
delay(1000);

})s

server.on("/socket20n", [1(){
server.send(200, "text/html", webPage);
digitalWrite(gpio4 pin, HIGH);
delay(1000);

})s

server.on("/socket20ff", [](){
server.send(200, "text/html", webPage);
digitalWrite(gpio4_pin, LOW);
delay(1000);

})s

server.begin();

println("HTTP server started");

loop( M
server.handleClient();
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ESP8266 IP Address

Open the Arduino serial monitor at a baud rate of 115200. After a few seconds,

your IP address should appear. In my case it’s 192.168.1.70.

m I

& COM3 - m} X
Send
31 100, 14 | 000001 i 0p@r, D420 * D0k, (NoB foned S04ppEZL { LrérldeY |Edd | DDDDEDEsE0B | 2,212 (»c@0pd ~
Copnected to MEO-_E20R4R
IF address: 192.168.1.70

ELLT IEIpondeEr JTAIT
HITP server atarted

] Autoscrol Molneendng 115200 baud -

Now follow the schematics below to create your web server to control two

IZIZIIIIIIﬁ}ESﬁJSEEESE
-

e & & & o
e o 0 o o
e o 0 o o
e o 0 o o
e o 0 o o
e e e o @
e o o o o
e e e o @
e o 8 o o
* e e o o
e & & & 0
e e @ o 0
e o 0 o o
e o 0 o o
e o e o 0
e o 0 s o
e o e o o
e o 0 s o
e e e o 0
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Demonstration

For the final demonstration open any browser from a device that is

connected to the same router that your ESP is. Then type the IP address and

click Enter!

o= 62% [ 18:31

(LT}

192.168.1.70

ESP8266 Web Server

Socket #1  ON | OFF

Socket #2 | ON | OFF

Congratulations for completing this project!
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Download Other RNT Products

Random Nerd Tutorials is an online resource with electronics projects,

tutorials and reviews.

Creating and posting new projects takes a lot of time. At this moment,
Random Nerd Tutorials has nearly 150 free blog posts with complete
tutorials using open-source hardware that anyone can read, remix and apply

to their own projects: http://randomnerdtutorials.com

To keep free tutorials coming, there’s also paid content or as I like to call

“premium content”.

To support Random Nerd Tutorials you can download premium content here.

If you enjoyed this eBook make sure you check all the others.

Thanks for taking the time to read my work!
Good luck with all your projects,
-Rui Santos

P.S. Click here for more courses and eBooks like this one.

Click here to Download other Courses and eBooks
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